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CHAPTER 1

Introduction to the Cisco Business Edition
6000H/M

* Who Should Use This Guide?, on page |
» Essential Documents for Installation of the Business Edition 6000H/M Appliances, on page 2

Who Should Use This Guide?

This guide helps you set up your Business Edition appliance if you can answer yes to the following questions.

* Are you doing a manual installation of applications on a Cisco Business Edition appliance? This guide
covers everything that you have to do to customize it for your business needs.

Are you installing application versions from Collaboration System Release 12.7 or later? If yes, this
installation guide applies. If no, then your applications may not support ESXi 7.0 and you cannot leverage
the factory-loaded software. Applications from Collaboration System Release 11.x are no longer

factory-installed on appliances as of time of this writing?

* Does your deployment fit within the Supported Solution Capacities described in Appendix B?

\}

Note Cisco partners can find more information on the http://www.cisco.com/go/bepartner.

A

Caution Do not reinstall the factory-loaded virtualization software. Do not reformat the disks or rebuild the storage

hardware array. Either action wipes out the factory preloaded software and causes post installation licensing
problems.

Business Edition 6000 Appliances are shown in following:
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Figure 1: Business Edition 6000 Appliances
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Essential Documents for Installation of the Business Edition
6000H/M Appliances

You can proceed with the installation by using the instructions in this document, refer the following documents
that are listed for Deployment Options, Equipment, and Applications. All of these documents are available
at the http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
tsd-products-support-series-home.html

Choose the product version, and then refer to the following documents:

* Deployment Options—To gain insights to help you plan your deployment, see the Preferred Architecture
guides and the Cisco Validated Designs that are relevant to your business needs.

 Equipment—Use the Quick Start Guide to unpack the appliance and install it in a rack.

* Applications—To find out more about applications, see the following documents:

» Cisco Business Edition 6000 and Cisco Business Edition 7000 Co-residency Policy
Requirements—This document contains information on the Cisco virtualized applications that are
available for installation on a Cisco Business Edition 6000 system and the conditions that you must
meet to run those applications and any third-party applications on a Business Edition appliance.

* Business Edition 6000 Software Load Summary—This document contains information on ISO and
OVA files that are pre-loaded in your server's datastore.

* Other documents for UC applications are listed on the Component Documentation tab.
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CHAPTER 2

Installation of Cisco Business Edition 6000H/M

* Design Your Deployment, on page 3
* Set Up Your Appliance, on page 5
* Set Up Your Applications, on page 14

Design Your Deployment

Review the following topics to design your deployment.

Plan Your UC Applications

Before You Begin:

Make sure that your Cisco Business Edition 6000 server is rack-mounted and connected to power and data
networks. For instructions, refer to the Quick Sart Guide for Cisco Business Edition that was packaged with
your server. You can also download a copy at:

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-installation-guides-list.html

Before you begin any installation, plan which UC applications you are going to install.

For information on the UC applications that are available for installation, and on how to design your Business
Edition collaboration deployment refer to the following sites:

» Cisco Business Edition 6000 and Cisco Business Edition 7000 Co-residency Policy Requirements—This
document contains information on the Cisco virtualized applications that are available for installation
on a Cisco Business Edition 6000 system and the conditions that you must meet to run those applications
and any third-party applications on a Business Edition server.

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-device-support-tables-list.html

+ Unified Communicationsin a Virtualized Environment—This website contains information on Cisco
Collaboration Virtualization applications and how to design your deployment.

http://www.cisco.com/go/virtualized-collaboration

» Preferred Architecture Guidesfor Midmarket—Preferred Architecture documents and CVD guides offer
prescriptive, end-to-end system solutions for Collaboration and Voice deployment. The design overviews
provide a basic understanding of the products and their roles in the Preferred Architectures, including
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high-level best practices. The CVD guides provide more detailed design and deployment recommendations
that help streamline the implementation of Preferred Architectures.

http://www.cisco.com/go/pa

» Midmarket Collaboration CVD Guides—Midmarket CVDs provide detailed design and step-by-step
deployment information for collaboration solutions that are built on the Cisco Business Edition 6000.
These CVDs are based on the core recommendations of the Preferred Architectures, and in sometimes,
they offer more solution designs as extensions or alternatives to the Preferred Architectures.

http://www.cisco.com/go/pa

+ Business Edition 6000 Software Load Summary—Preload Summary documents provide information on
ISO and OVA files that are pre-loaded in your server's datastore.

https://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-release-notes-list.html

Collect Required Network Information
Collect the following network settings for your installation:
* Subnet mask
* Gateway IP Address
* VMware vSphere ESXi IP address
* VMware vSphere ESXi management IP address
* Cisco Integrated Management Controller (CIMC) IP address
* UC application IP addresses
* DNS server IP address
» UC application hostnames
* (Optional) Domain name
* NTP server IP address
* Time zone

* (Optional) SMTP server

)

Note For general information on the Cisco UCS C220 M5SX server that is used in Cisco Business Edition 6000,
see the Cisco UCS C220 M5 Server Installation and Service Guide. Cisco Intersight, Cisco UCS Manager,
Cisco CIMC Supervisor do not support managing BE6000 appliances.

Decide how you will interconnect the appliance to your network. Specifics on network interconnection options
are beyond the scope of this guide, but below are some important callouts.
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Set Up Your Appliance .

For the full range of possible configuration settings options, consult Cisco UCSC220 M5 Rack Server (Small
Form Factor Disk Drive Model) Spec Sheet, Cisco UCSC Server Installation and Service Guide and
docs.vmware.com.

Available physical ethernet ports depend on the appliance model:

* All M5 appliance models include modular LAN on motherboard ports as described in the Cisco UCS
C220 M5 Rack Server (Small Form Factor Disk Drive Model) Spec Sheet.

* BE6000OH model includes additional ports via a network interface card.

» It is not supported on any appliance model to add network interface cards, add virtual interface cards, or
change included network interface card.

)

Note Available VMware vSphere ESXi configuration settings options depend on what license is being used. If your
appliance is using an embedded virtualization license,VMware vSphere ESXi distributed virtual switch features
are not enabled.

Set Up Your Appliance

Review the following topics before you begin your installation.

Installation of Virtualization and Application Software

This section describes the tasks that you must perform to install virtualization and application software on
your Business Edition 6000 , using the factory preload.

Preloaded File Types in the Datastore

In addition to pre-deployed virtual machines, Cisco Business Edition servers are shipped with selected
Collaboration application software that is pre-loaded on the datastore. Following is a breakdown of the file
types for application installs:

* | SO Files—An ISO file is a DVD image containing application install files (for example,
Bootable UCSInstall UCOS 12.5.1.10000-22.sgn.iso).

An ISO file is present for a UC application only if the OVA file for that application does not include the
application software.

» OVA Files—Each UC application has an associated Open Virtualization Archive (OVA) file, which is
used to package and deploy the virtual machine. There are two types of OVAs for Business Edition
servers:

* Some OVAs (e.g. cucm_12.5 vmv13 v1.0.ova) are templates that define the VM, but do not include
any application software. For those applications, there is an associated ISO file in the datastore (for
example, Bootable UCSInstall UCOS 12.5.1.10000-22.sgn.iso). For the installation, you must
deploy the OVA template and install the software using the associated ISO file.
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. Installation Task Flow of the Cisco Business Edition 6000H/M

* Other OVA files define the VM and include the application software (for example,
Bootable-CiscoPagingServer 12.5.1.ova). For these applications, there is no ISO
file. You can deploy the VM and install the software using the OVA file.

For information on which ISO and OVA files are pre-loaded in your server's datastore, refer to the preload
summary for your server at the http://www.cisco.com/c/en/us/support/unified-communications/
business-edition-6000/products-release-notes-list.html.

Note

Cisco recommends that you archive the OVA-ISO directory locally. If there is a hardware failure, replacement
hardware does not include a factory preload. If the factory preloaded software is either deleted, overwritten,
or lost, then manual rebuild of preloaded software is required. Restore to the factory default capability is not
supported.

Installation Task Flow of the Cisco Business Edition 6000H/M

Perform the following tasks to install software on your Cisco Business Edition 6000 server.

Procedure
Command or Action Purpose

Step 1 Configure Cisco Integrated Management Configure CIMC for your Business Edition
Controller, on page 6 6000 server.

Step 2 Customize Virtualization Software Remote Configure the pre installed VMware vSphere

Access, on page 9Customize Virtualization ESXi software on the appliance.
Software Remote Access

Step 3 Delete Unused or Unwanted Virtual Machines, | Delete any pre deployed VMs that you do not
on page 13 require.

Configure Cisco Integrated Management Controller

Cisco Integrated Management Controller (CIMC) is the management interface for the Cisco UCS appliance.
CIMC runs within the appliance, allowing remote administration, configuration, and monitoring of the appliance
through web or SSH command-line access.

Complete the following tasks to configure CIMC on a Business Edition 6000 appliance for customized and
preconfigured deployments.

Complete the following tasks to Configure Cisco Integrated Management Controller:

Procedure

Command or Action Purpose

Step 1 Power on and Initial CIMC Setup, on page 7

Step 2 Complete the CIMC Configuration, on page 8
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Power on and Initial CIMC Setup .

Power on and Initial CIMC Setup

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Use this procedure to power on the appliance and begin the basic Cisco Integrated Management controller
(CIMC) configuration.

Before you begin

Ensure that the Business Edition 6000 appliance has been rack-mounted, connected to a power supply,
connected to the data network, and that a monitor and keyboard are connected to the appliance, as described
in the Quick Start Guide.

Procedure

Verify that power is connected and that the power button LED is orange.

Push the appliance power button and verify that it changes to green.

Watch the boot process on the monitor.

When the blue Cisco logo appears, press F8 to enter the CIMC configuration dialog.
Figure 2: Press F8 at the CIMC Boot Screen

e
CISCO

When prompted, enter the username admin and create a new password.
On the CIMC configuration screen, complete the following details:
* CIMC IP address

* Subnet mask
* Gateway IP address
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. Complete the CIMC Configuration

Figure 3: Enter the CIMC IP Address Details
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Step 7 When complete, press F10 to save your changes and boot the system.

Complete the CIMC Configuration
Use this procedure to configure DNS and NTP settings in the CIMC interface.

Before you begin

Power on the appliance and begin basic Cisco Integrated Management Controller(CIMC) configuration.

Procedure

Step 1 In a web browser, enter the CIMC IP address and log in with the username admin and the password that you
created in the previous task.

Step 2 From the left menu, select the Admin tab, and click Network.
Step 3 In the home page, select the Network Settings tab.
Step 4 From Common Properties, change the Hosthame setting to the CIMC hostname.

Step 5 From | Pv4 Properties, change Preferred DNS Server to the IP address that you have specified for the DNS
server.

Step 6 In the home page, select the NTP Settings tab.

Step 7 Check the Enable NTP check box.

Step 8 In the Server 1 field, enter the NTP server IP address.

Step 9 Select Save Changes from the bottom right corner of the page.
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Configure Virtualization Software
Complete the following tasks to set up the VMware vSphere ESXi:

Procedure

Command or Action Purpose

Step 1 Customize VMware vSphere ESXi Remote
Access.

Step 2 Access and Configure the VMware vSphere
ESXi.

Customize Virtualization Software Remote Access

Follow this procedure to customize the VMware vSphere ESXi to enable remote access from your PC using
the VMware Embedded Host Client.

N

Note BE6000 appliances factory loaded with ESXi 7.0 are built with vimfs6. BE6000 appliances factory loaded
with ESXi 6.5 are built with vinfsS5. if you want to change the vimfs version, check application support and
note you will have to rebuild the appliance.

Procedure

Step 1 When the hypervisor boots, the ESXi Direct Console User Interface displays on the monitor as shown in the
following figure.

Figure 4: Console Screen After ESXi Loads

IF the Factary prelosd Is deletsd or overurite se any prelosded enbedded uirtualization License.

ppLications on this appliance MUST be grazefully shutdoun before removing pouer. Failure to shut doun
a loss.

ALY running appli
gracerully nay result in dat;

453855

Step 2 Press F2 to enter the System Customization menu as shown in the following figure.
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. Customize Virtualization Software Remote Access

Step 3

Step 4

Figure 5: ESXi System Customization Menu

The default username is root and default password is ¢! SCo123.

System Customization Conf igure Password

Conf igure Hode
Conf igure Hanagenent Metuork
Restart Management Netuork
Test Managenent Hetworle
Hetwork Restore Options

Conf igure Keyboard
Troubleshoot ing Opt ions

View Systen Logs
View Support Informat ion
Reset System Conf igurat jon

VMuare ESXi 6.5.0 (¥ 4 Build 4564186)
After logging in, you must change the default password, choose Configure Passwor d to change the password.
If your applications are pre-deployed, skip to Step 5, on page 11.

To assign a static IP address, select the Configure M anagement Networ k menu, and follow the instructions
on screen to change “IP Configuration”.
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Figure 6: Assign Static IP Address to ESXi Host
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Step 5 Connect your PC to the data network, and browse to the new hypervisor IP address.

Figure 7: Hypervisor Welcome Page

w0a@10302620 = | Keo = | (G

Rocont tasks

Access and Configure Virtualization Software

Some Business Edition applications require the host to have a valid time reference. Follow these steps to
access the ESXi host to configure NTP and configure fault tolerance for network interface cards (NICs) using
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. Access and Configure Virtualization Software

Step 1

Step 2
Step 3

Step 4

the NIC teaming feature, view preinstalled applications, and browse the datastore to verify the preloaded
collaboration application software.

Before you begin

Customize Virtualization Software Remote Access, on page 9

Procedure

Browse to the “https://[ESXI-HOST-IP-Address]/ui/” to access VMware Embedded Host Client.

Figure 8: Access Virtualization Software Using VMware Embedded Host Client

0 @ - brtpe//10.30.26.20/ui/# login B = @ Cenificare ervor Log in - VMware ESXi

vmware ESXi

Use the login credentials that you previously configured.

If selected at time of quoting, BE 6000 appliances are factory loaded with a Collaboration embedded OEM

license for such as Cisco Business Edition Embedded Virtualization Basic . If you want to use this license, it

is ready for use. If you want to re upload or version-upgrade this license, follow these steps:

a) Locate your license document that has license serial number for the such as Cisco Business Edition
Embedded Virtualization License . For installations, license serial number ships from the factory along
with the appliance. For version-upgrades, license serial number ships from the My Cisco Entitlements
(MCE)" on cisco.com.

b) Navigate to Manage > License> Assign License.

¢) Type in or copy or paste the license serial number from the license document.

d) Click Check Licenseto validate the license key.

Note Embedded virtualization licenses do not work the same way as regular vSphere ESXi licenses or
Partner Activation Codes (PAC). They are hardcoded to 2-CPU, pre combined, and cannot split or
expand through myvmware.com. They are neither a VMware Partner Activation Code (PAC) nor
a Cisco Product Authorization Key (PAK). They are pre activated, no registration or activation on
myvmware.com or cisco.com required. They does not support installation through vCenter, license
pooling in vCenter, or any vCenter features.

For more details, see the Appendix C.

Configure NTP settings:

a) Navigate to Manage > System > Time & date.
b) Click Edit settingsto launch the Edit time configuration screen.
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Step 5

Step 6

Step 7

Delete Unused or Unwanted Virtual Machines .

¢) Check Manually configurethe date and time on thishost check box.

d) Update the Time.

e) Check the Use Network Time Protocol (enable NTP client) check box.

f) Select Start and stop with host from NTP service startup policy drop-down.

g) Type the IP address of NTP server in NTP servers. If you want to add multiple NTP servers, type the IP
address of NTP servers that are separated by commas.

h) Click Save.

(Optional) Configure fault tolerance by using the NIC teaming feature in VMware:

a) Navigate to the Networking > Management Network.

b) Click Edit settingsto launch Edit port group- Management Network.

¢) In the Edit port group- Management Network screen, enter the name, VLANID, Virtual switch.
d) Expand NIC teaming, enter the required details.

e) Click Saveto add the NIC that is connected to the data network.

Note By default, only one NIC is enabled for the hypervisor and identified as vmnicO0.

Browse the datastore:
a) Navigate to Storage > Datastore to list the datastores in the Business Edition appliance.
b) Select datastorel.

¢) Click the Datastore browser. You can view the Preloaded Collaboration Virtual Machines and preloaded
software.

Note You must select the VMFSS file type while creating the datastore.

Figure 9: Browse Datastore to View Preloaded Collaboration Virtual Machines and Preloaded Software

vmware Esxi' 010302620 ~ | Hep v |
T3 Navigator [ 3 localhost.localdomain - Storage
= @ Host Dalastores Adapters Devices
Manage
Monitor 3 New datastore £y Register a VM Ly Datastore browser C Refresh [+ %:]]
1 Wirtual Machines Name v Dive Type~ Capacty ~ FProvisio.. « Free v  Type ~ | Thin po.
= Storage [a

€3 Networking

(Optional) Cisco recommends that you archive the OVA-ISO directory locally. If fails, the replacement
hardware does not include preloaded content.

Delete Unused or Unwanted Virtual Machines

You can optionally delete unused or unwanted preloaded files to free up disk space or make room for subsequent
installations in the following scenarios:
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* [f you want to deploy a new application version or patch level than the existing factory-preloaded
application.

* If you do not want to run a particular preloaded application and its files.

Procedure

Step 1 Log in to VMware Embedded Host Client.
Figure 10: Delete Any VMs That You Are Not Using
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4 Export
(3> Edit settings n
&, Permissions N
# Editnotes
]l Rename et
BEAK-OVAF
Unregister
I _ Delete

Step 2 Expand Virtual Machines and locate the virtual machine that you want to delete.

Step 3 If the VM has a green triangle, right-click the icon and select Power > Power Off.
The green arrow disappears as the VM powers off.

Step 4 Right-click the VM and select Delete.

Step 5 Repeat this procedure for each virtual machine that you wish to remove.

Set Up Your Applications

Perform the following tasks to set up your applications on the Cisco Business Edition 6000 appliance.

Procedure

Command or Action Purpose

Step 1 Deploy Virtual Machine OVAs, on page 15 Deploy virtual machine OVAs for each UC
application that you want to install.
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Deploy Virtual Machine OVAs .

Command or Action

Purpose

Step 2

Customize Virtual Machines for Cisco Unity
Connection, on page 16

If your Business Edition 6000 deployment
includes Cisco Unity Connection, customize
the Unity Connection VM.

Step 3

Associate Application ISO Files to Virtual
Machines, on page 17

For UC application installations that require an
ISO file, mount the ISO file on the application
VM.

Note For a list of applications that use ISO
installation files, see the Pre-Load

Summary for your appliance.

Step 4

Install UC Applications Using Touchless
Installation, on page 18

Optional. Use touchless installation to install
any of the following core UC applications:

* Cisco Unified Communications Manager
* IM and Presence Service
* Cisco Unity Connection

* Cisco Unified Contact Center Express

Note If you prefer, you can use manual

installation for these applications.

Step 5

Install UC Applications Manually, on page 21

Use the manual interactive process to install
any remaining UC applications.

Deploy Virtual Machine OVAs

For each application that you want to run, requires one of the preloaded virtual machine OVA files. If a new
version is preferred, then it is recommended to delete the existing version.

Depending on the preloaded application, the OVA contains any of the following applications:

* Fully installed ready to run application

» Partially installed application

* VM configuration alone for an empty virtual machine

For more details, see the Preload File Summaries in Release Notes at the http://www.cisco.com/c/en/us/support/
unified-communications/business-edition-6000/products-release-notes-list.html.

Note

The OVA template files that contain empty virtual machines are deployed in seconds, while larger OVA files

that contain partially or fully installed applications can take longer to deploy.
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. Customize Virtual Machines for Cisco Unity Connection

A

Caution

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8
Step 9
Step 10
Step 11
Step 12
Step 13

To ensure proper operation of your appliance and any embedded virtualization licenses, ensure it is running
ESXi 6.5 U2 or greater, with the Cisco UCS-specific image of ESXi.

Procedure

On the VMware Embedded Host Client, navigate to the Virtual Machines.
Right-click the Virtual machines and select the Create/Register VM.

Select Deploy a virtual machine from an OVF or OVA file as select creation type.
Specify a meaningful name for the virtual machine.

Browse and select the source OVA template file on your PC. For application and filename mapping, see the
Build Summary PDF in the datastore OVA-ISO directory, or download from here: http://www.cisco.com/c/
en/us/support/unified-communications/business-edition-6000/products-release-notes-list.html.

Select the datastore in which to store the configuration and disk files.

Select the deployment options.

If prompted to accept license agreements, continue to click Next.

Select the deployment options.

If prompted for the Disk Format, specify Thick Provision Lazy Zero.
Review your settings selection before finishing the wizard.

Click Next.

Deploy VMs for all your UC applications before proceeding to the next task.

If your system includes Cisco Unity Connection, then Customize Virtual Machinesfor Cisco Unity Connection.
Otherwise, Associate Application 1SO Filesto Virtual Machines.

Customize Virtual Machines for Cisco Unity Connection

Step 1
Step 2
Step 3

For Customized installations, use this procedure to configure your Cisco Unity Connection virtual machine
settings to ensure optimum performance.

Preconfigure

Before you begin

For Customized installations, use this procedure to configure your Cisco Unity Connection virtual machine
settings to ensure optimum performance. Deploy Virtual Machine OVAs, on page 15

Procedure
On VMware Embedded Host Client, navigate to the Virtual Machines.

Right click the Unity Connection entry and select Edit Settings.

If you want to use the Unity Connection, or Unified, or Integrated Messaging, do the following:
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a) Select the Virtual Hardware tab.
b) Select the CPU menu and set the number of Cores per Socketsto 2.
¢) Inthe Reservation tab, increase the reservation to 3598MHz.

For more information, see the https://www.cisco.com/c/en/us/td/docs/voice ip comm/connection/12x/
supported_platforms/b_12xcucspl.html.

Associate Application ISO Files to Virtual Machines

If you have deployed a skip-install OVA that contains any of the following partially installed applications,
skip this step.

* Cisco Unified Communications Manager
* IM and Presence Service

* Cisco Unity Connection

* Cisco Unified Contact Center Express

* Cisco Emergency Responder

If you have deployed an OVA that contains ready to run fully installed applications, skip this step.

For all other OVA files that contain only VM configurations of empty virtual machines, use this procedure
to associate the ISO installation files that is used to complete the installation.

Note For an up to date list of installation files for your appliance, see the Preload Summary for your appliance in
the datastore OVA-ISO directory or at: http://www.cisco.com/c/en/us/support/unified-communications/
business-edition-6000/products-release-notes-list.html .

Procedure

Step 1 In the VMware Embedded Host Client, select the UC application virtual machine.

Step 2 Click Edit .

Step 3 From Virtual Hardware tab, select CD/DVD Drive 1.

Step 4 Select Datastore | SO File from CD/DVD Drive 1 drop-down list.

Step 5 Browse to the datastore and locate the application ISO file.

Step 6 Select the file and click Select.

Step 7 In CD/DVD Drive 1, check the Connect at power on check box under the Status.

Step 8 Repeat this procedure for each application that you want to install that includes an ISO file.
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Install UC Applications Using Touchless Installation

Touchless installation allows you to install multiple UC applications and virtual machines of an application
simultaneously, across the different hosts if necessary, without having to interact with the system while the
install process runs. While you must prepare the system, touchless installation can save time, particularly if
you want to install multiple applications. If you are installing only one or two applications, you may prefer
to follow the manual procedure in the following section.

Use touchless installation to install the following applications:

* Cisco Unified Communications Manager

» IM and Presence Service

* Cisco Unity Connection

* Cisco Unified Contact Center Express

* Cisco Prime Collaboration Deployment

Procedure

Command or Action

Purpose

Step 1

Generate Answer Files, on page 18

Generate answer files (AFG files) for UC
applications.

Step 2

Create Virtual Floppy Images, on page 19

Use your AFG files to create virtual floppy
images.

Step 3

Upload Virtual Floppy Images to Datastore, on
page 20

Upload your virtual floppy images to the
datastore.

Step 4

Mount Virtual Floppy on Virtual Machines and
Set Boot Option, on page 20

Mount each virtual floppy on the corresponding
UC application VM.

Step 5

Run Touchless Installation, on page 21

Run the touchless installation of your UC
applications. We recommend that you run your
installations simultaneously.

Generate Answer Files

Use this procedure to generate answer files for the touchless installation of your UC applications.

Je

Tip  We recommend that you create application-specific folders (for example, UCM, IMP, CUC, CCX) in which
to save the generated files so that you do not get the files mixed up.

Procedure

Step 1

Go to the online answer file generator at: www.cisco.com web cuc_afg .
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Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Create Virtual Floppy Images .

From the Product drop-down list, select the UC application for which you want to generate answer files.
Select the Version that you want to install.

Complete the remaining fields with the installation details that you want to configure on the appliance. For
example, you can assign items such as passwords, IP addressing, and DNS settings.

Click Generate Answer Filesto generate the platformConfig.xml file for that UC application.
Each UC application generates a platformConfig.xml file. Cisco Unified Communications Manager
also generates a clusterConfig.xml file.

Save the generated answer files as follows:

* For Cisco Unified Communications Manager, save both the platformConfig.xml and
clusterConfig.xml files in the UCM folder.

* For other UC applications, save the plat formConfig.xml file in the relevant application folder.

Repeat these steps for each UC application for which you want to use touchless installation.

Create Virtual Floppy Images

P

Tip

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7

Use this procedure to create virtual floppy images from the answer files. You will use the virtual floppy images
in your touchless installation.

We recommend that you follow the recommended naming conventions for your . £1p files.

Before you begin

1. You can use Winimage to create the virtual floppy images. You can download Winimage from
http://www.winimage.com/download.htm. You can also use other tools, such as BFI, to create virtual
floppy images.

2. Generate Answer Files, on page 18

Procedure

In Winimage, select File > New.

From the Standard format, select 1.44 M B and click OK.

Dragthe platformConfig.xml file for the UC application onto the Winimage window.
When prompted to inject the file into Winimage, click Yes.

Cisco Unified Communications Manager only. Drag the clusterConfig.xml file onto the Winimage
window.

Select File> Save As.
Save the file as a virtual floppy image (.flp file) using the following naming conventions:
* Cisco Unified Communications Manager—ucm. f1p
* IM and Presence Service—imp. flp
* Cisco Unity Connection—cuc. f1lp
* Cisco Unified Contact Center Express—ccx . f1p
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Step 8 Repeat this procedure for each UC application for which you want to use touchless installation.

Upload Virtual Floppy Images to Datastore

Use this procedure to upload the virtual floppy images to the datastore.

Before you begin

Create Virtual Floppy Images

Procedure

Step 1 Start the VMware Embedded Host Client.

Step 2 Select Storage.

Step 3 Right-click on a datastore and Browse the datastore.

Step 4 Navigate to the destination directory and click the Upload icon.
Step 5 Upload the vFloppy images to the AFG folder.

Step 6 At the Upload/Download warning, click Yes.

Step 7 Close the Datastore Browser window.

Mount Virtual Floppy on Virtual Machines and Set Boot Option

Use this procedure to mount the UC application virtual floppy images on their corresponding VM.

N

Note This step is not required for predeployed VMs as they are already configured.

Before you begin

Upload Virtual Floppy Images to Datastore

Procedure
Step 1 In the VMware Embedded Host Client, select the UC application virtual machine.
Step 2 Select Virtual Machine.
Step 3 Click Edit.
Step 4 From the Virtual Har dware tab, select Floppy drive.
Step 5 Select Use existing floppy image.
Step 6 Browse to the datastore and locate the virtual floppy image.
Step 7 Select the file and click OK.
Step 8 Under Status, enable the Connect at power on option.
Step 9 Click the VM Optionstab. Under Boot Options, check the Force BIOS setup, and then click Save.
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Step 10 Repeat this procedure for each UC application for which you want to perform touchless installation.

Run Touchless Installation

After you have mounted your virtual floppy drives to your application VMs, run the touchless installation
process. We recommended that you run all of your touchless installations simultaneously.

\}

Note If your VM is predeployed, you need to perform step 6 only.

Procedure

Step 1 In the VMware Embedded Host Client, right-click the VM and select the Console > Open console in new
window.
A console window opens.

Step 2 Click the Power On icon in the console toolbar to power on the virtual machine.
Step 3 When the BIOS screen appears, configure the following boot order:

a) CD-ROM

b) Hard Drive

¢) Removable Devices

d) Network

Step 4 Save the settings and exit the console.
The UC application installation commences immediately.
Step 5 Repeat these steps for each UC application that you want to install.

Step 6 Once the installations are complete, remove the vFloppy configurations from the virtual machines.

Install UC Applications Manually

Use this procedure to follow the interactive install process to install any UC applications that do not have a
touchless install option such as Cisco Emergency Responder.

Procedure

Step 1 In the VMware Embedded Host Client, power on the VM for the application that you want to install.

Step 2 Right-click the VM, and choose the Console > Open consolein new window.
A console window appears.

Step 3 Follow the screen prompts to install the application from the console.

Step 4 If you are using the manual method to install both Cisco Unified Communications Manager and IM and
Presence Service, once the Cisco Unified Communications Manager publisher node installation completes,
do the following:

a) From the VMware Embedded Host console, log in to the Cisco Unified Communications Manager CLI.
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b) Run the set network cluster subscriber dynamic-cluster-configuration 24 command.

¢) Opena VMware Embedded Host console window for the IM and Presence or subscriber virtual machine.
d) Power On the virtual machine.

e) Enter the configuration information for the application to complete the installation.

Step 5 Repeat this procedure for each UC application that you want to install.
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Post-Installation of the Cisco Business Edition
6000H/M

* Post-Installation of the Cisco Business Edition 6000H/M, on page 23

Post-Installation of the Cisco Business Edition 6000H/M

Complete the following procedure after the installation of Cisco Business Edition 6000H/M .

Procedure

Step 1 Licensing Applications, on page 23

Follow these steps to perform the first-time setup and apply licenses for your UC applications.

Step 2 Install Locales or Patches for Applications, on page 25

Install new locales for your UC applications.

Licensing Applications

Applications licensed with Cisco Smart Licensing: Applies to Cisco Unified Communications Manager
12.5 preloaded on Business Edition 6000. Please see the Cisco Smart Licensing for Unified Communications
Manager 12.5 BE600O-specific LicensesBE6000 Starter Pack Licenses and the Cisco Smart Software Licensing
with Cisco Unified Communications Manager Solution Overview. Skip this section.

Applicationslicensed with Product Authorization Keys(PAKS): Applies to Cisco Unified Communications
Manager 11.5 preloaded on Business Edition 6000.

Note 11.x applications are not preloaded on appliances with virtualization software version 7.x. License logistics
information for 11.x applications is kept here for convenience.
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Follow these steps to access each application, perform the first-time setup for some applications, and apply
the licenses.

Procedure

Step 1 To access the administration portal for each individual application, browse to the IP address of application.
Consider the following information:

* (Optional) For Paging Server installations: Collect information about the application URL from the
virtual machine console. The default first-time username and password are admin and changeMe.

» Cisco Prime Collaboration Provisioning: Browse to the IP address and use globaladmin as the
username.

« Cisco Prime Callaboration Assurance and Analytics Business: Browse to the IP address and use
globaladmin as the username.

» Cisco Prime Collaboration Deployment: Browse to the IP address and use the Administrator account
and password you specified during installation. For more information, see the Cisco Prime Collaboration
Deployment Administration Guide, Release 11.5(2) Admin Guide.

Step 2 After you purchase an application license, Cisco sends a Product Authorization Key (PAK) through mail or
email. You can use the PAK to generate a license key for your specific installation using the Cisco Product
License Registration portal at the www.cisco/go/license or you can enter the information directly in Cisco
Prime License Manager.

Step 3 Apply license keys using the application administration portal. Refer to the following points for licensing
information specific to whichever applications that you have installed:

* Cisco Prime Collaboration Provisioning: No license is required to use Cisco Prime Collaboration
Provisioning Standard Edition. You may purchase an upgrade to Cisco Prime Collaboration Provisioning
Advanced Edition if necessary.

* Cisco Prime Collaboration Assurance and Analytics: No license is required to use Cisco Prime
Collaboration Assurance Standard Edition. You may purchase an upgrade to Cisco Prime Collaboration
Assurance Advanced and Analytics or Advanced Edition if necessary.

* Cisco Prime Collaboration Deployment: No license is required to use Cisco Prime Collaboration
Deployment Edition, as the Cisco Prime Collaboration Deployment license is entitled by the Cisco
Unified Communications Manager license.

* Paging Server: No license is required to use Basic Paging Server. You may purchase an upgrade to
Advanced Edition if necessary.

* Unified Communications Manager, Cisco Unity Connection, and Cisco Emergency Responder:

Note Cisco Prime License Manager (PLM) gets installed automatically as part of the Cisco Unified
Communications Manager and Cisco Unity Connection installation. Use only the instance that
is installed with the Unified Communications Manager publisher to manage all of your licenses.
Do not use separate Prime License Manager instances to manage Unified Communications
Manager and Unity Connection licenses separately. For details, see the Cisco Prime License
Manager User Guide at: http://www.cisco.com/c/en/us/support/cloud-systems-management/
prime-license-manager/products-user-guide-list.html. Alternatively a standalone instance of
PLM may be installed using the files in the datastore.
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Install Locales or Patches for Applications

Complete the following tasks to install locales or patches for your application VMs.

\}

Install Locales or Patches for Applications .

Note

http://software.cisco.com for more recent updates.

* Patches that are shipped with the appliance were current at the time of manufacture. Visit

* For additional information on locales, refer to the Phone Locale Installers wiki at: http://docwiki.cisco.com/
wiki/Cucm-phone-locale-installers.

Procedure

Command or Action

Purpose

Step 1

Associate Bundled Locale or Patch ISO with
Virtual Machines, on page 25

Associate the locale or patch installer with the
appropriate VM.

Step 2

Stop Services for Unity Connection, on page
26

If you want to install locales or patches for
Cisco Unity Connection, stop the services
before you install the locale or patch.

Step 3

Install New Locales or Patches, on page 26

Install the locale or patchon the VM.

Associate Bundled Locale or Patch ISO with Virtual Machines

Before you begin

Use this procedure to associate your locale or patch images with the appropriate application VM before starting
the install process.

Procedure

Step 1
or patch.

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Click Edit .

From Virtual Hardware tab, select CD/DVD Drive.
Select Datastore | SO File from CD/DVD Drive 1 drop-down list.
Browse to the datastore and select the appropriate locale or patch ISO file.
Click Select.
In CD/DVD Drive 1, check the Connect at power on check box under the Status.

Repeat this procedure for each VM for which you want to install a new locale or patch.

In the VMware Embedded Host Client, select the Virtual Machine on which you want to install a new locale
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Stop Services for Unity Connection

Use this procedure if you want to install a new locale or patch for Cisco Unity Connection. You must stop
services on the Unity Connection VM before you install a new locale or patch.

Procedure
Step 1 Log in to Cisco Unity Connection Serviceability.
Step 2 Choose Tools> Service M anagement.

Step 3 Stop the following services:

* Connection Conversation Manager
* Connection Mixer

Install New Locales or Patches

Use this procedure to install a new locale or patch for any UC applications on your Business Edition appliance.

N

Note * For Cisco Unified Communications Manager, you must install locales or patches for the publisher node
and restart it before you install it for any subscriber nodes.

* You can install locales for Cisco Unified Communications Manager and Cisco Unity Connection in
parallel.

Procedure

Step 1 Log in to Cisco Unified Communications OS Administration.

Step 2 Navigate to Software Upgrades> Install/Upgrade. The Software I nstallation/Upgrade window displays.
Step 3 From the Sour ce drop-down list box, choose DV D/CD.

Step 4 Click Next.

Step 5 Select the update file that you want to install and click Next.

Step 6 After the download completes, click Next.

Step 7 After the locale or patch installs, restart the appliance:

a) Log in to the VMware Embedded Host Client
b) Right-click the VM on which you installed the locale or patch and select the Guest OS> Restart

What to do next

After you install your Cisco Business Edition 6000 appliance, you can provision users, devices and configure
features on the system. Refer to the following guides:

* Cisco Prime Collaboration Provisioning Guide
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* Supported Solution Capacities, on page 27

Supported Solution Capacities

This section presents some of the supported deployment limits for the coresident applications on Cisco Business
Edition 6000. It is important to stay within these limits while planning system utilization to avoid
oversubscribing an appliance.

Application Performance Limits

Unified Communications Manager * 150 Users / 300 Endpoints for BE6000S.

* 1000 Users / 1200 Endpoints for BE6000M

* 1000 Users / 2500 Endpoints for BE60OOH.

* Total 50 CUCM Locations / Gateways / Sites

* 50 Extension Mobility login or logout every hour.
* 50 Music On Hold sessions/calls.

* 20 Software Conferences

* 250 CTI endpoints

* 150 Presence enabled Users for BE6000S

* 1000 Presence enabled Users for BE6000M or
BE6000H

* LDAP Authentication and Synchronization
* Clustering & Redundancy
* Overall BHCA 5000
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Application

Performance Limits

Cisco Unity Connection

* 150 Users / 150 Voicemail boxes for BE6000S.

* 1000 Users / 1000 Voicemail boxes for BE6000M
or BE60OOOH.

* 24 Voicemail ports with maximum 6 VUI ports, @
1000 BHCA

* 500 IMAP sessions
* 150 CPCA sessions

Unified Communications Manager — Instant
Messaging & Presence Service

* 150 Users for BE6000S, 1000 Users for BE6000M
or BE600OH

* XMPP Load
* 20 IM per user per hour
» 2 State changes per user per hour

* 20 contacts per user

Unified Contact Center Express/IP IVR

* 100 Agents @ 15 BHCA per Agent (BE6000M or
BE600OH only)

* 10 Recording Sessions
* 100 IVR Sessions
* Periodic Historical reporting

For more details, see Cisco Unified Contact Center
Express Design Guides.

Cisco Emergency Responder

For more details, see datasheets.

Cisco Unified Attendant Console

* Up to 50 operators
* Up to 100 queues
+ Different music in different queues

Comparison between various CUXAC editions.

Cisco Expressway with registrations, or

Cisco Video Communication

* 100 Traversal and non-traversal calls
* Up to 30 MCUs

For more details, refer to Cisco VCS-C Datasheet.

Cisco TelePresence Server Virtual Machine

For 10HD ports per VM

Cisco TelePresence Management Suite

For BE6000 Deployment - see TMS Installation
Guide.
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Application

Performance Limits

Cisco Paging Server

+ 1000 Users

* Pre-recorded / schedule broadcast

* Notification

* 911/emergency call monitoring / alerting / recording
* Weather Alerting

* 50 Users per paging group

Cisco Prime Collaboration Provisioning

* 150 Users on BE6000S

* 1000 Users on BE6000M or BE600OH

* 150 phones or voice terminals on BE6000S

* 1200 phones or voice terminals on BE6000M
* 2500 phones or voice terminals on BE6000H

For more details, refer Quick Start Guides and Install
and Upgrade Guides.
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Cisco Smart Licensing for CUCM 12.5
BE6000-specific Licenses

* Cisco Smart Licensing for Unified Communications Manager 12.5 BE6000-specific Licenses, on page
31

Cisco Smart Licensing for Unified Communications Manager
12.5 BE6000-specific Licenses

For a general overview of Cisco Smart Licensing, and how it is used in conjunction with Unified
Communications Manager 12.0 and higher, see the Cisco Smart Software Licensing with Cisco Unified
Communications Manager Solution Overview.

The instructions in this appendix only apply if you have purchased BE6000-specific UCL and UWL 12.5
starter packs and add on user licenses. These licenses are described in the Business Edition 6000 Ordering
Guide available to partners and Cisco employees.

* If you are using a different license offer (such as non-BE6000-specific UCL, UWL, Enterprise Agreement
or Collaboration Flex Plan), stop now and see the Cisco Smart Software Licensing with Cisco Unified
Communications Manager Solution Overview for instructions.

* Smart Licensing for BE6000-specific licenses are only available for Collaboration System Release from
12.5 and above.

* Unified Communications Manager 12.5 in BE6000-specific licensing requires use of Cisco Smart
Licensing, and for the UCM 12.5 Publisher to have 'BE6000 mode' enabled using the CLI.

* Remember that Unified Communications Manager 11.5 in BE6000-specific licensing continues to require

the use of Cisco Product Authorization Keys (PAKs) and Cisco Prime License Manager, not Cisco Smart
Licensing.

* You must create a Cisco Smart Account (this can be done prior to installation). You must deposit the
newly purchased BE6000 12.5 licenses in this account. Installed base customers must migrate licenses
to 12.5 and deposit in this account.

1. Obtain your BE6000-specific 12.5 licenses. These instructions assume that you have already completed

the required purchase/fulfillment processes. Partners and Cisco employees may consult the Business
Edition 6000 12.5 Ordering Guide.
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2. Provision your Smart Account / Virtual Account in Cisco Smart Software Manager; ensure that your
BE6000-specific licenses are assigned to your Smart Account / Virtual Account.

For more information, see the Cisco Smart Software Licensing with Cisco Unified Communications
Manager Solution Overview.

Ensure that your BE6000-specific licenses for starter packs and add-on users are properly assigned to
your Smart Account / Virtual Account.

See the following screenshot of Cisco Smart Software Manager showing a Smart Account/Virtual Account
that has BE6000 12.5 specific and starter pack licenses assigned to it:

rmare Eofmare L kceming - angri L Mo Smes S—

Smart Software Licensing
Wirtual ACcount UCK-Saurabh -

Lacanssm

LEEnse HEse a0 (] it S o

Letenge B P rased In Balawce  Aeris hCiery

=

384019

3. Obtain a Registration Token for Unified Communications Manager 12.5 from Cisco Smart Software
Manager.

For more information, see the Cisco Smart Software Licensing with Cisco Unified Communications
Manager Solution Overview.

See the following screenshot of where the Registration Token is copied or downloaded from (you will
need this in step 6):
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4. Install Unified Communications Manager 12.5 (or version-upgrade Unified Communications Manager
from an older release to 12.5).

When Unified Communications Manager in BE600O is initially installed as 12.5, or version-upgraded
from an older release to 12.5, Unified Communications Manager 12.5 immediately enters the following
modes:

* Registration Status 'Unregistered'.

* License Authorization Status 'Evaluation Mode'. Unified Communications Manager 12.5 remains in
'Evaluation Mode' for either 90 days, or until it is registered with Cisco Smart Software Manager
(whichever comes first).

* Licensing Mode 'Enterprise’.

The following is a screenshot of what the initial mode settings look like immediately after you install of
Unified Communications Manager 12.5 and configured devices in it:
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If 'Evaluation Mode' ends after 90 days without registration, then Unified Communications Manager 12.5
enters 'Enforced Mode', and administrative changes are disabled.

After registration, Unified Communications Manager 12.5 periodically syncs with Cisco Smart Software
Manager (CSSM) to verify authorization status of Unified Communications Manager 12.5 and validates
the customer’s registered licenses with locally consumed or used licenses for this Unified Communications
Manager 12.5 cluster. If CSSM reports 'Authorization Expired' or insufficient quantity of registered
licenses vs. consumed/used licenses, then, Unified Communications Manager 12.5 enters 'Out of
Compliance' status. You have an overage period of 90 days to bring licensing back into compliance, at
the end of which Unified Communications Manager 12.5 enters 'Enforced Mode', and administrative
changes are disabled.

For more information, see the Cisco Smart Software Licensing with Cisco Unified Communications
Manager Solution Overview.

5. Set the Unified Communications Manager 12.5 cluster to 'BE6000 mode' and specify which BE6000
starter pack you want to use.
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On the Unified Communications Manager 12.5 Publisher node, run the platform command line interface
utils BE6GOOOM ode enable and specify which BE600O starter pack license you use for your install of or
version-upgrade to 12.5:

* BE6000 UCL Starter Bundle (for UCL Enhanced + voicemail)
* BE6000 UWL Starter Bundle (for UWL Standard)
* NONE

The following is a screenshot of the command line to use:

S000 CL Starter Bundle.

As an example, see the following screenshot about what Unified Communications Manager 12.5 displays
immediately after being placed into 'BE6000 mode' with 'BE6000 UCL starter bundle' (shows consuming
or using one unit that has not yet been requested from registered licenses in Cisco Smart Software Manager):
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6. Register the BE6000 Unified Communications Manager 12.5 with Cisco Smart Software Manager, using
the Registration Token.

For more information, see Cisco Smart Software Licensing with Cisco Unified Communications Manager
Solution Overview.

Enter the Registration Token obtained in Step 3 on the Unified Communications Manager 12.5 Publisher.
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The Unified Communications Manager 12.5 Publisher then attempts to request and consume or use a
single BE6000 Starter Bundle from your registered license inventory on Cisco Smart Software Manager.
The starter bundle feature-level requested is the one you specified at the time of running the platform
command line interface utils BEGOOOM ode enable. A Unified Communications Manager 12.5 cluster
with its Publisher in 'BE6000 mode' may only request and consume or use a single BE600O starter pack
license. The cluster may request and consume or use any number of BE6000-specific or
non-BE6000-specific addon user licenses, subject to capacity limits of BE6000 solutions.

As an example, for a successfully registered and authorized Unified Communications Manager 12.5 in
'BE6000 mode' using a BE6000 UCL starter pack, see the following screenshots of what you would see
on the Unified Communications Manager 12.5 Publisher and on Cisco Smart Software Manager (showing
consuming or using one unit that is authorized and registered):
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Starter Bundle License Consumption

The following is a screenshot of what the initial mode settings look like immediately once you install Unified
Communications Manager, after customer configuring the devices in 12.5:
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The following image shows the change in the License consumption for the above selection:
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Addon User License Consumption

In BE6000 mode, Unified Communications Manager 12.5 consumes BE6000 Starter Bundle addons along
with Enterprise addons.
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License Management

You are currently running in Evaluation mode. To register your system with Cisco Smart Software licensing:

- Ensure your system has access to the internet or 3 Smart Software Manager satellite installed on your network. This might require you to edit the Licensing Smart Call Home Transport settings,
A\ - Login to your smart account in Smart Software Manager or your Smart Software Manager satellite.
=) - Navigate to the virtual account containing the licenses to be used by this Product Instance.

- Generate a Product Instance Registration Token(to identify your Smart Account) r save it

- Return to this page, dick the Register button, and use the copied or saved Token to register the product.

[-Smart Software Licensing
Registration Status A ynregistered
License Authorization Status A\ Evalustion Mode (80 days remaining)
Export-Controlled Functionaiity Not Allowed
Call Home settings
Licensing Mode BES000
Register

Below is 2 summary of current license usage on the system. Current usage details for each type are available by pressing "Update Usage Details". Note that collecting these datz is a resource intensive process and may take several minutes to complete, depending on
the size of your deploymen

Wiew All License Type Descriptions And Device

Update Usage Details | Usage Details Last Updated: 2020-03-08 10:55:20

License Type Current Usage status Report
cuwL 1 Users(1) | Unassianed Devices(0 )

Enhanced Plus 1 users(1)

Enhanced 6 *Users(0 ) | Unassioned Devices( 41 )

Basic 1 Users(0) | Unassigned Devices( 1)

Essential 1 Users( 0} | Unassigned Devices( 1)

T e 1 M evaluation Users( 0 ) | Unassigned Devices{ 1)

BEG000 UCL Starter Bundle 1 A evaluation

BESO00 UWL Starter Bundle o No Licenses in Use

= indicates some or all licenses are from 2 BEG000 Starter Bundle

Users and i i
Users a View Usage Report
Unassigned Devices a4 View Usage Report

o
0
o]
o
=
n

’rsman Licensing Product

The licenses for this system are managed by Smart Software Manager
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APPENDIX c

Rebuilding a Business Edition 6000 Appliance

* Rebuilding a Business Edition 6000 Appliance , on page 41
» Hardware and Virtualization Software Reinstall, on page 41
* Reapplying Embedded Virtualization License, on page 41

Rebuilding a Business Edition 6000 Appliance

Use this appendix for the following situations:

* Appliance hardware replacement or RMA.

* Software reinstallation caused by hardware replacement, disk reformatting, RAID rebuilds, virtualization
software reinstall/upgrade or other factors.

* Reapplying an embedded virtualization license key.

Hardware and Virtualization Software Reinstall

If hardware needs to be re-provisioned, or VMware vSphere ESXi needs to be reinstalled, follow the instructions
in Cisco Collaboration on Virtual Servers at https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/
virtual/CUCM_BK C90DIBE9 00 cisco-collaboration-on-virtual-servers.html

* BE6000M (MS5) appliance corresponds to UCS C220 M5SX TRC#1.
* BE600OH (M5) appliance corresponds to UCS C220 M5SX TRC#2.

Reapplying Embedded Virtualization License

Check Cisco Commerce Services & Subscriptions or My Cisco Entitlements on cisco.com to see what
virtualization software options your appliance ordered.

If your appliance was ordered with one of the following options, then it has an embedded virtualization license:
* BE6K-VIRTBAS-7X
* BE6/7K-VIRTBASP-7X
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* BE6/7K-VIRTENH-7X
* VMW-VS6-HYPPLS-K9
* VMW-VS6-FND-K9
* VMW-VS6-CVSTD-K9
If you instead ordered the appliance with option VIRT-LIC-NONE, or you have substituted a different

virtualization license, then you do not have an embedded virtualization license and the instructions below do
not apply.

By VMware’s design, embedded virtualization licenses work differently from general-purpose VMware
vSphere ESXi licenses.

* They are supported by Cisco TAC; do not contact VMware for support.
* They may not be managed at myvmware.com.

* They are neither VMware.com Partner Activation Codes (PAC) nor Cisco Product Authorization Keys
(PAK).

* Licenses are pre-activated serial numbers and do not require or support activation on myvmware.com.
* They are pre-combined to fixed 2-CPU, and cannot be split or expanded through myvmware.com.

» They must be applied to the appliance through the Embedded Host Client, never through vCenter. They
do not support being applied by vCenter, or being added to vCenter license pools.

* For more details, see http://www.cisco.com/c/dam/en/us/td/docs/voice ip_comm/uc_system/
%?20virtualization/virtualization-software-requirements.html#license_comparison

Embedded virtualization licenses are master keys. If you purchased multiple appliances with the same embedded
virtualization license option, they will all use the same license serial number for the initial install. If you
version-upgrade to a new major release (e.g. 6.x to 7.x), then vCenter-supporting licenses will become a
license key unique to each appliance.

You must apply the embedded virtualization license serial number as-is to an appliance using Embedded Host
Client, NOT through vCenter. Trying to apply through vCenter will either not work at all or will only work
for some of the appliances you purchased.

If you tried to apply for an embedded virtualization license serial number through vCenter, follow the steps
below to “un-do” (“host” refers to the appliance as an ESXi host):

* In vCenter, make sure the host is standalone (NOT managed by vCenter): from vCenter, remove the host
from inventory (important: don’t just “disconnect”).

» While the host is standalone (NOT being managed by vCenter): in Embedded Host Client on the host,
select & remove/delete any existing license key, then enter/assign the embedded virtualization license
key.

* Back to vCenter: re-add the host to inventory. It should show up with the embedded master key that was
entered in step 2.
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